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New Features

The following new features have been added in version 11.4 of TIBCO Spotfire® Analyst.

For details about new Spotfire features, see What's New in TIBCO Spotfire in the TIBCO Community.

Key Version Summary

TSDC-6778 11.4.1 New preference for setting the CommandTimeout for Microsoft SQL Server
connections

It is now possible to set the CommandTimeout for the TIBCO Spotfire Microsoft SQL
Connector via a preference. It is located under Connectors > Microsoft SQL Server in
the Administration Manager in the Analyst client.

TSDC-6798 11.4.1 New preferences for disabling UseDeclareFetch and Fetch for PostgreSQL
connection

There are now two preferences for controlling the UseDeclareFetch and Fetch
connection settings for the TIBCO Spotfire PostgreSQL connector. They are located
under Connectors > PostgreSQL in the Administration Manager in the Analyst client.

SPOT-1440 11.4.0 Single-tenant authentication support for SharePoint Online Lists

The TIBCO Spotfire Connector for SharePoint Online Lists now supports single-tenant
authentication. 

SPOT-499 11.4.0 Parallel data loading and computing

Data is now loaded and computed in parallel when opening an analysis file. This can
shorten the data loading time when you use data from multiple data sources. You will
also get all (non-error) prompts up front, which means that data loading can continue
until completed, without interruptions for prompts.

Using the installed client, it is possible to switch off the parallel data loading entirely
under Tools > Options > Document > Data loading, or, for a single analysis, through
File > Document properties > Compatibility Settings. An administrator can also
control the preferences for a group in Administration Manager > Preferences >
Application > DataImportPreferences.

SPOT-1445 11.4.0 Databricks SQL Analytics support

The TIBCO Spotfire connector for Apache Spark SQL now supports Databricks SQL
Analytics. You can now perform self-service visual data discovery on data lake data
using live pushdown querying in Databricks clusters which have SQL Analytics
enabled.

TS-65517 11.4.0 Improved feature rendering in map charts

Spotfire uses geometry simplification techniques to facilitate the rendering of detailed
features on spatial maps, still preserving essential shapes. However, for rectangle
features that are typically represented by 4 or 5 points, the simplification might cause
rendering inconsistencies. In such cases you can specify the number of points below
which geometry simplification will not be used for features with less than 6 points.

TS-65959 11.4.0 Client Library API now includes new library item types

The client library API is extended to include new library item types that are returned
from the Search API.
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Key Version Summary

SPOT-1191 11.4.0 Added options for library items in the Files and data flyout

It is now possible to rename and delete items in the Spotfire library directly from
the Files and data flyout. You can also copy links to library items to share them with
others. To access the new options, right-click a library item in the Spotfire library
section of the Files and data flyout.

SPOT-1351 11.4.0 Automatic proxy detection

Python Tools Package Management now attempts to detect system proxy settings
automatically and uses them if they are available when searching for, or installing,
 Python packages. Additional custom configuration options have been added to the
Administration Manager.

SPOT-1455 11.4.0 Improved performance for visualization mods

The performance of visualization mods has been significantly improved. The transfer
of data (rows and hierarchies) is now at least 100% faster for large data views and on
par with the performance of native visualizations.

SPOT-374 11.4.0 Trellising multiple layers in a map chart

The trellising of a map chart can now comprise more than one layer of data. This
makes it possible to compare multiple measures or categories of data within a single
geographical or diagrammatic map.

TS-66059 11.4.0 Improved user action logging

Changing page through an IronPython script is now logged in the user action log.

TS-66349 11.4.0 Custom repository setting for Python packages

The Spotfire administrator can now set a custom Python package repository for
use with Python Tools. To specify a custom repository for data function authors,
 from the Spotfire Administration Manager Preferences dialog, set DataFunctions >
DataFunctionPreferences > PythonPackageRepositoryIndexURL.

TIBCO Spotfire® Analyst Release Notes
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Changes in Functionality

The following are important changes in functionality in version 11.4 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-69964 11.4.4 Updated log4net.dll

The log4net.dll has been upgraded from 2.0.12 to 2.0.15.

TSDC-7026 11.4.4 Removed fixed value for MaxBytesPerFetchRequest in connections to Apache Spark
SQL

When you access data with the connector for Apache Spark SQL, there is no longer a
fixed value for the connection property MaxBytesPerFetchRequest. The value is now
determined by the default value of the ODBC driver you use.

TS-69018 11.4.3 The included Python Interpreter is updated to 3.8.13.

TSDC-6946 11.4.3 Fixed value for MaxBytesPerFetchRequest in connections to Apache Spark SQL

When you access data with the connector for Apache Spark SQL, the value of the
connection property MaxBytesPerFetchRequest is now always 10MB, even if the
ODBC driver has a different default value.

TS-68382 11.4.2 Updated version of numpy

The Python package numpy was updated to 1.21.0

TSDC-6690 11.4.1 Increased timeout for metadata queries with the Spark connector

When using the TIBCO Spotfire connector for Spark, the timeout for metadata queries
has been increased from 30 seconds to 1800 seconds.

TSDC-6735 11.4.1 Possible to define local redirect address template for Google connectors

It is now possible to define the local redirect address template for the TIBCO Spotfire
connectors for Google as a preference.

TSDC-6814 11.4.1 Updated driver for TIBCO® Data Virtualization

The driver for TIBCO Data Virtualization has been updated to version 8.5.0.

SPOT-1283 11.4.0 Unified experience for saving to, and browsing in, the library

The same UI and style in the Files and data flyout is now used when saving an
analysis in the Spotfire library as when browsing the library. This unified experience is
available in the installed client as well as the web client.

TS-65168 11.4.0 Save login information in Cloud Analyst

The 'Save my login information' option is now available for people connecting using
TIBCO Cloud Spotfire Analyst.
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Key Version Summary

TS-66505 11.4.0 The spotfire Python module moved from the Core module to the Python Interpreter
module

The spotfire Python module for Analyst support of Python data functions has
moved from the Core module to the Python Interpreter module. If the Spotfire
Server administrator has deployed a custom Python interpreter package to the Spotfire
Server, then attempts to run data functions fail with errors about the spotfire module
(and mention using pip install).

This failure with errors will continue until the Spotfire Server administrator deploys to
the Spotfire Server a new custom Python interpreter package that is built with version
1.3.0 (or later) of the spotfire Python package.

TS-66507 11.4.0 The Spotfire package available for download on PYPI

The Spotfire package is now a package available on PYPI and can be downloaded
by using the standard pip command. This change makes creating packages for
distribution simpler. If you are using your own Python interpreter, you can simply
install the 'spotfire' package using pip instead of extracting the wheel from the
distribution and installing it.

TS-66550 11.4.0 Updated Python interpreter

The Python interpreter included with Spotfire has been updated to version 3.8.10.

TS-66555 11.4.0 Increased max length of string mod properties

The maximum allowed length for mod properties of string type is now 100KB instead
of 2KB.

TS-66560 11.4.0 New location for SetupLauncher when installing Spotfire

SetupLauncher, the program that performs the installation of a new version of Spotfire
Analyst, is now downloaded from the deployment area to a folder in the user's
AppData folder instead of a Temp folder.

The locally installed version of the program has been removed from the Modules
folder.

TS-66631 11.4.0 Automatic signaling of render complete

A visualization mod automatically signals render complete when an error overlay is
shown.

TSDC-6516 11.4.0 Performance changes for importing data with Amazon Redshift connections

To improve performance when you import data from Amazon Redshift, the option
SingleRowMode is now enabled by default. You can override this by adding the
SingleRowMode option in the Additional settings table and setting the value to 0.

TSDC-6525 11.4.0 Disabled caching improves import performance

In the TIBCO Spotfire MySQL connector, the NO_CACHE, FORWARD_CURSOR and
PREFETCH options are now used to improve import performance.

TSDC-6526 11.4.0 Improved import performance for the PostgreSQL connector

The UseDeclareFetch option is now enabled in the TIBCO Spotfire PostgreSQL
connector to improve import performance.

TSDC-6660 11.4.0 For the TIBCO Data Virtualization connector the property enableFlood is activated
for requests from Spotfire, which could make communication with TIBCO Data
Virtualization unstable.

TIBCO Spotfire® Analyst Release Notes
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Deprecated and Removed Features

Deprecated features

The table lists features that are deprecated and will be removed in a future release of TIBCO Spotfire®

Analyst.

Key Version Summary

TS-63679 11.4.0 The API to create requests to the server APIs , WebRequestFactory.
CreateSpotfireWebRequest(), has been deprecated in this release. All requests
to the server should be made using the standard APIs WebRequest.CreateHttp or
WebRequest.CreateDefault instead. Authentication and authorization to the server
APIs is done using OAuth2 and registered API client credentials. See the following
documentation for more information.

Spotfire Server SOAP APIs

Spotfire Server REST APIs

Web Services API Reference

Library REST API

Deprecated since Spotfire 10.10.0.

TS-66424 11.4.0 The jQuery 1.12.4 and jQuery UI 1.9.2 JavaScript libraries will not be distributed with
future releases of TIBCO Spotfire®. Your use of these third party libraries, whether
in this release, past releases, or future releases of TIBCO Spotfire, is at your own
discretion, and is not supported or warranted by TIBCO. Please see Best Practices for
Writing Custom JavaScript Code in Text Areas for additional information on using
JavaScript code with Spotfire® products.

Deprecated since Spotfire 11.4.0.

Removed features

No features have been removed in this release of TIBCO Spotfire® Analyst.
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Closed Issues

The table lists important closed issues in version 11.4 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-69044 11.4.4 Pasting data when the Spotfire client is in a modal state will cause the client to enter an
unusable state.

TS-69517 11.4.4 In some cases, reference lines based on Line from Data Table do not show up in the
correct trellis panel when multiple scales are used.

TS-69557 11.4.4 Load balancers (especially an AWS load balancer) between the Spotfire Analyst and
the Spotfire Server or between node services and the Spotfire Server can cause random
connection problems.

TS-69674 11.4.4 In cross tables and heat maps, formatting specified on column level is not applied to
color item values in the legend, when the default color scheme grouping is used.

TS-69881 11.4.4 The Spotfire client is closed unexpectedly when writing certain types of invalid search
expressions.

TSDC-6942 11.4.4 In the Microsoft SharePoint Online Connection dialog, it is not possible to add a
SharePoint Site if the URL contains spaces or encoded spaces (%20).

TSDC-6965 11.4.4 When you access data from Salesforce, an error occurs if a query from Spotfire to
Salesforce contains more than 16,000 characters.

TSDC-7010 11.4.4 Expressions that contain an aggregating function within a column function (where the
latter accepts more than one argument) cannot be used as a calculated column or as a
visualization axis expression.

This affects the connectors for SAP HANA (when using Analytical Views), Attivio,
 and IBM Netezza.

TSDC-7030 11.4.4 When you access data with the connector OData, an unnecessary request header is
included that sometimes causes the request for data to fail.

TS-68260 11.4.3 Using the ‘Image from URL renderer’ in table visualizations containing many cells
could cause rendering of the visualization to timeout.

TS-68263 11.4.3 When exporting a map chart, in some cases the transparency for base layers is not
shown correctly.

TS-68307 11.4.3 In some cases where the aspect ratio of the map chart has been changed in a previous
action, the visible area might shift strangely when a user releases the mouse button
after panning the map.

TS-68333 11.4.3 Some older analysis files containing invalid marking selections cannot be opened due
to mismatch in Row count.

TS-68344 11.4.3 In line charts, marking a single line by clicking on it, does not work when there are
multiple expressions on the Y-axis.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-68387 11.4.3 On the 'Sorting' page of the Visualization Properties for table visualizations, sometimes
the column that is displayed as selected in the drop-down list, is not the column that
was actually selected.

TS-68389 11.4.3 Calls to the TERR service or Spotfire Service for Python that uses data functions do not
set the content length on the requests, which can cause issues when used with some
proxy servers.

TS-68415 11.4.3 Windows Forms controls registered on a background thread in custom extensions
might cause the application to become unresponsive after a system event has been
triggered.

TS-68439 11.4.3 In rare conditions, the application might become unresponsive if custom code runs in a
progress operation.

TS-68601 11.4.3 In map chart image layers, some images are unnecessarily stored twice in .dxp files.

TS-68627 11.4.3 If your server is configured with unconstrained Kerberos delegation, then accessing
external data sources using your Windows account can fail.

TS-68657 11.4.3 When you edit a data source in Information Designer and click 'Save As...' to save a
copy of the data source with a new name, the name of the original data source can
change instead if the saving fails (for example if you forget to enter the password).

TS-68717 11.4.3 A mod signed with a certificate, where there is no method to check the revocation
status of the certificate because revocation is not supported by the certificate authority,
 is considered to have an invalid signature.

TS-68720 11.4.3 When reading data from certain streams (for example, via TIBCO Spotfire Statistics
Services, including when Statistics Services is called through Automation Services), an
internal issue causes data to be only partially read, and the data is therefore corrupted.

TS-68739 11.4.3 The single_user installation does not work for usernames containing characters from
other alphabets than the basic Latin alphabet.

TS-68753 11.4.3 Clearing the check box ‘Visualization title visible by default’ in Tools > Options >
Visualization does not hide the visualization title.

TS-68790 11.4.3 Some multithreaded Python data functions never finish when run locally.

TS-68798 11.4.3 If you run Microsoft .NET Framework version 4.5.2 or earlier and attempt to upgrade
Spotfire, the upgrade progress will close unexpectedly.

TS-68811 11.4.3 If you run Microsoft .NET Framework version 4.5.2 or earlier and attempt to upgrade
Spotfire, the upgrade progress will close unexpectedly.

TS-68840 11.4.3 Log files currently opened for writing by another process cannot be added as a data
source.

TS-68846 11.4.3 Shapefiles containing geometries with unspecified measure values are not loaded
completely.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-68883 11.4.3 When opening an analysis, and there are both automatically executing data functions
and on-demand data tables that depend on the output of the data functions, then the
on-demand action sometimes initially fails to fetch new data.

TS-68145 11.4.2 Running local Python data functions is unnecessarily slow.  This has now
been partially addressed by enabling bytecode generation for all local Python
data functions. You can return to the previous behavior by defining the
PYTHONDONTWRITEBYTECODE environment variable.

TS-68178 11.4.2 Prompting for proxy authentication or certificate warnings can sometimes freeze the
application if it is performed on a background thread.

TS-68193 11.4.2 In map charts, Position settings in image layers cannot be edited when the mouse is
used.

TS-68204 11.4.2 Page tabs are sometimes missing if the Spotfire analysis was created in a background
web browser tab.

TS-68215 11.4.2 Spotfire clients cannot be used with proxy servers that return multiple authentication
types.

TS-68232 11.4.2 The map chart can occasionally blink, or even become blank for a short period, when it
is rendered very frequently.

TS-66838 11.4.1 The ODBC connection pool is cleaned up after all connections have been returned to
the pool, which could, in combination with specific ODBC driver implementations,
 result in a deadlock.

The fix only addresses the Load data with ODBC, OLE DB, or ADO.NET data provider
import method.

TS-66840 11.4.1 Vertical scale labels are not visible in bar charts and combination charts with certain
fonts.

TS-66866 11.4.1 When applying a bookmark containing a heat map, sometimes extra columns named '
Row cluster IDs' or 'Column cluster IDs' are created.

TS-66906 11.4.1 Logging of some actions does not work.

TS-66923 11.4.1 Application Profiler times out when an analysis contains a data table from a data
function.

TS-66949 11.4.1 Setting document properties through configuration blocks, when having an on-
demand request that needs data that has not yet been loaded, makes Spotfire close
unexpectedly.

TS-67007 11.4.1 The table visualization fails to render some shapes that display correctly in the map
chart.

TS-67077 11.4.1 When using TIBCO Cloud Spotfire Analyst or the cloud web client, library items are
not shown if you first click on any of the shared folders.

TS-67080 11.4.1 When launching Spotfire Analyst from a CLI and using the /offline parameter, the
client is not opened in offline mode as expected.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-67148 11.4.1 When opening and closing analyses inside a transaction via the API, the progress
indicator sometimes gets stuck.

TS-67159 11.4.1 Spotfire closes unexpectedly when trying to remove visualizations with certain
layouts. This occurs when there is no splitter that constitutes an exact border for the
removed visualization.

TS-67163 11.4.1 In some cases, on-demand data cannot be loaded after replacing an information link in
the library.

TS-67168 11.4.1 In the map chart, an exception is thrown in some trellising scenarios.

TS-67176 11.4.1 When configuring "Label and Tooltip" for "Lines & Curves" in the Visualization
Properties dialog, the values are sometimes shown in a mix of languages. Some values
are shown in the current language and some are shown in the language used when the
line or curve was created.

TS-67178 11.4.1 Analyses that include multiple data tables and a specific combination of markings can
sometimes not be opened when loading data in parallel.

TS-67179 11.4.1 A calculated column referencing the DataType property can sometimes get the old
value if the data type has changed when loading data in parallel.

TS-67383 11.4.1 Hovering with the mouse pointer over items in the Lists panel does not display any
annotations.

TS-67392 11.4.1 The TIBCO logo in the OAuth2 web page "Authentication Successful" cannot be
cobranded.

TS-67404 11.4.1 In Administration Manager, when editing the ReferencePoints of
the BoxPlotPreferences, it is not possible to define a color for a given
BoxPlotPointPreference.

TS-67407 11.4.1 Hierarchical scales prioritize the top level labels when the scale is given less vertical
space than intended.

TS-67457 11.4.1 Pasting data when the Spotfire client is in a modal state will cause the client to enter an
unusable state.

TS-67518 11.4.1 String columns are not read correctly when shapefiles are uploaded.

TS-67561 11.4.1 Data functions executed on an authenticated TIBCO Spotfire® Statistics Services server
can experience performance issues.

TS-67581 11.4.1 When selecting a non-default coordinate reference system via the API, for a map chart
or any of its layers, the selected coordinate reference system does not show up in the
drop-down list on the properties/settings pages.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-67650 11.4.1 Requests to TIBCO Spotfire Statistics Services sometimes time out after 10 seconds,
 even though some requests would benefit from a longer timeout period (the server
default of 3600 s).

With this fix, only the initial request to a server uses the short timeout period, to
avoid long waiting times when a server is not up and running. The length of the short
timeout can now be changed using a new preference: TIBCO Spotfire Statistics
Services > StatisticsServices > Server Connect Timeout Seconds

TS-67676 11.4.1 When adding another transformation to the same transformation group as a
previously added Pivot transformation, the value columns are missing if no column
titles were chosen in the Pivot operation.

TS-67688 11.4.1 Bookmarks seem to be randomly deleted from the library after the API tries to modify
or delete other users' bookmarks.

TS-67723 11.4.1 When running an information link, the values provided in the prompts do not
override the current parameters.

TS-67738 11.4.1 Running a data function with very large input data using either TERR or Python can
result in a failure with the error "Error from Remote Service: Internal Service
Error (500)."

TS-67811 11.4.1 When saving data or analyses to the library, some HTTP requests to the server do not
set the content length as expected. This can cause problems if proxy a server is used.

TS-67813 11.4.1 A data function that uses a column search expression fails to execute during reload if a
previous input column no longer is available.

TSDC-6678 11.4.1 When using the TIBCO Spotfire connector for Apache Spark SQL, long-running
queries are canceled due to the limited ODBC command timeout. The ODBC
command timeout for the Spark SQL connector has now been increased to 30 min.

TSDC-6684 11.4.1 The TIBCO Spotfire connector for TIBCO Data Virtualization sometimes stops
responding when many queries are sent at the same time.

TSDC-6692 11.4.1 Due to a change in the driver, newer versions of the MariaDB driver (3.1.13 and later)
 do not work correctly with the TIBCO Spotfire connector for MySQL.

TSDC-6696 11.4.1 When reading metadata from SAP HANA, view definitions and comments are
included, which causes performance issues in large SAP HANA instances. With this
fix, these columns are now excluded from the metadata extraction.

TSDC-6771 11.4.1 Some Oracle 11g data tables with a primary key are not loading in Spotfire Analyst
using the Oracle Connector.

TSDC-6801 11.4.1 An error occurs when a custom query has a parameter and a column that share the
same name.

TS-38646 11.4.0 The documentation about marking in visualizations contains too little detail about the
behavior when using Ctrl+A.

TS-48313 11.4.0 The documentation about use of prepocessor expressions (for example, when
using document properties inserted as text) is not clear enough. See Properties in
Expressions and related topics.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-65520 11.4.0 Failure to persist author trust to the server is not reflected in the mods trust dialogs.

TS-65953 11.4.0 When exporting a prepared report to PDF, headers and footers are sometimes
rendered incorrectly.

TS-65973 11.4.0 File URIs do not work in the "Image from URL" renderer.

TS-65984 11.4.0 If you use Spotfire Service for Python to run Python data functions, and you use
Spotfire Statistics Services to run TERR data functions, then the client (either Spotfire
Analyst or Spotfire Business Author) can mistakenly try to run the TERR data
functions in a nonexistent TERR service, rather than Spotfire Statistics Services,
 causing the data function to wait indefinitely. 

TS-66105 11.4.0 The location search field and button are pushed behind the other navigation controls
in some trellised map charts. 

TS-66143 11.4.0 Frozen columns originating from data functions disappear when opening the analysis.

TS-66186 11.4.0 When exporting a trellised scatter plot, only the image labels for the first trellis panel
are exported when the display option ‘Image from URL’ is used.

TS-66219 11.4.0 Spotfire closes unexpectedly when all values are deleted from a drop-down list with
fixed values during editing of a text area.

TS-66244 11.4.0 Map charts sometimes stop updating when panning is done on a page with iframes on
it, for example JSViz or visualization mods.

TS-66247 11.4.0 Sometimes, usage.log files that contain cluster identifiers are not parsed correctly.

TS-66320 11.4.0 A certain script, which applies a large number of markings in an analysis with wide
data, runs much slower in version 10.x and 11.x of Spotfire compared to version 7.x.

TS-66338 11.4.0 In a scatter plot, the Spotfire client sometimes closes unexpectedly when switching
between post-aggregating expressions on an aggregated axis using Time as the data
type.

TS-66342 11.4.0 Memory usage increases when running a specific script that applies a large number of
markings in an analysis with wide data and a tabular visualization.

TS-66343 11.4.0 In some cases it is possible to replace individual values from the UNIQUE values
overview in the column details in the Data in analysis flyout even though it should not
be possible.

TS-66462 11.4.0 Right-clicking top scale labels in a heat map results in errors in some situations.

TS-66522 11.4.0 Loading information links might cause issues when running several TIBCO Spotfire
Server instances (clustered TSS).

TS-66531 11.4.0 After installing TIBCO Spotfire version 10.9 or higher on a computer where another
version is already installed, it is not possible to uninstall any of the versions. 

With this fix, uninstalling TIBCO Spotfire no longer leaves unwanted files on disk,
 when multiple versions have been installed on the same computer. 

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-66649 11.4.0 For some Microsoft Excel cells that use array formulas, empty values are incorrectly
imported.

TS-66707 11.4.0 If you try to install an older version of Spotfire, while having a newer version installed,
 then the old installer exits and the Windows Settings/Apps page shows an additional
Spotfire application item that cannot be uninstalled.

TS-66723 11.4.0 If an error occurs while signing in to SharePoint Online using the TIBCO Spotfire
SharePoint Online connector, the real error is hidden by a more general error.

TS-66729 11.4.0 Preference values that are specified in a cobranding package are not used the first time
a different user than the previous user logs in.

TS-66734 11.4.0 Sometimes it is not possible to zoom in or out in the map chart using the + and -
 buttons that are available in the visualization, even though it should be possible.

TS-66784 11.4.0 It is not possible to reload an embedded data table when it is based on an on-demand
source and has added rows from a different data source.

TS-66797 11.4.0 When using ApplicationThread.Invoke in custom code together with Automation
Services, Qualification or Application Profiler, pending invocation attempts might be
executed in the wrong context.

TS-67829 11.4.0 The property InformationLinkTimeoutMinutes, which you can use in the
Information Designer to set a timeout for individual information links, is not
documented.

TSDC-6566 11.4.0 When using the Google BigQuery connector to import data, the import sometimes
consumes a lot of memory, which might lead to performance issues.

TSDC-6575 11.4.0 In the documentation there is not enough information about admin consent issues in
Microsoft Azure when connecting to SharePoint Online. 

TSDC-6583 11.4.0 For the TIBCO Spotfire connectors for Drill, Dremio, and Snowflake, connections are
not closed properly. This results in an accumulation of open connection handles. For
example, in the case of Snowflake connections, when logging is enabled, the driver
sometimes does not release log file handles until the connection is closed. This causes
the process to eventually run into the limit of allowed number of open file handles.

TSDC-6623 11.4.0 Google Analytics is mentioned in the documentation about using a credentials profile
with Google data, but usage of credential profiles is not yet supported in the TIBCO
Spotfire Google Analytics connector.

TSDC-6649 11.4.0 Authenticating a SharePoint Online connection using the client information from
preferences fails in the installed client with an error message stating that the client is
public.
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Known Issues

The following are known issues in version 11.4 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-69770 11.4.3 Export error displayed for empty column

If you export an SBDF from Python (for example, as outputs for a data function), and
your output contains an empty column, then you can encounter the following error:

spotfire.sbdf.SBDFError: cannot determine type for column 'EmptyString'

; all values are missing

This error occurs because the spotfire package cannot always correctly infer data types,
 such as String.

Workaround: None.

TS-62137 11.4.0 Python packages that are installed by the Administrator (through an SPK) take
precedence over packages installed using the Python Tools from the Spotfire Analyst
Tools menu. If users attempt to update a package previously installed by an SPK, then
the package update is installed, but the update is ignored.
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Installation

The following are instructions on how to install version 11.4 of TIBCO Spotfire® Analyst.

The TIBCO Spotfire® Analyst client is delivered as two different installers. The installer labelled
"single_user" is the default one. Use this if you do not know which version to select. The installer
labelled "single_user" installs the product for the logged in user only. The other users on the same
machine will not be able to use the client. The installer labelled "shared_computer" installs the product
for all users on the machine. This installer requires administrative privileges on the machine.

Installation of Release 11.4

1. First install/upgrade the TIBCO Spotfire® Server to version 11.4.

2. Deploy the TIBCO Spotfire® 11.4 distribution on the TIBCO Spotfire® Server 11.4.

3. Finally, install TIBCO Spotfire® Analyst 11.4 on all client computers.

Installation Notes

● If the .NET 4.5 framework is not installed, it will be downloaded and installed when launching the
"shared_computer" TIBCO Spotfire® Analyst client installer. The "single_user" installer will not
download the .NET framework, because it does not have system changing privileges. However, it
will complain if the .NET framework is missing.

● If the product localization is defined as a user group preference, a client restart is required after
the initial login to the server for the changes to be fully applied. Note that clients are not informed
that such a restart is required. It is also important that the appropriate localization packages are
deployed to the TIBCO Spotfire® Server prior to setting the user group preference.

Note that the correct Language pack and the matching server preference must be set on the very
first server that the user connects to. Changing the settings on the Server will not have any effect. If
the localization group preference does not have any effect, it can be enforced on clients using Tools
> Options.

TIBCO Spotfire® Analyst Release Notes
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Migration and Compatibility

The following are instructions on how to migrate from a previous release to version 11.4 of TIBCO
Spotfire® Analyst.

Upgrading from Previous Version without Installing

1. First install/upgrade the TIBCO Spotfire® Server to version 11.4.

2. Deploy the TIBCO Spotfire® 11.4 distribution on the TIBCO Spotfire® Server 11.4.

3. Start the old version of TIBCO Spotfire® Analyst, log on to the TIBCO Spotfire® Server 11.4 and
accept the update.

With Spotfire 10.3, a trust mechanism for data functions was introduced. Also, the trust stamp
was changed to be calculated with SHA-512. Therefore, when updating from an older version to
10.3 or later, the trust stamps in all Spotfire analysis files in the library that include IronPython
scripts, JavaScripts, data connection custom queries or data functions must be updated. New
server CLI commands called "find-analysis-scripts" and "trust" can be used to find and update
or automatically trust old scripts and data functions in your library. For more information, see
the TIBCO Community article: https://community.tibco.com/wiki/script-and-data-function-trust-
spotfire-103-and-later.

Compatibility Versions

You can use TIBCO Spotfire 11.4 to open .dxp analysis files that were created and saved in any older
version of Spotfire that is still in support.

The compatibility versions of TIBCO Spotfire 11.4 are updated to versions 11.3 and 10.10 LTS. This
means that .dxp analysis files that you create and save in Spotfire 11.4 can be opened in versions 11.3
and 10.10 LTS of Spotfire.

When you use an older version of Spotfire to open an analysis file that was created in a newer
version of Spotfire, features from the newer version might not be available, and the analysis
might look and behave differently compared to the version in which it was created.

Version Compatibility versions

11.4 LTS 11.3, 10.10 LTS

11.3 11.2, 10.10 LTS

11.2 11.1, 10.10 LTS

11.1 11.0, 10.10 LTS

11.0 10.10 LTS, 10.3 LTS

10.10 LTS 10.9, 10.3 LTS

10.9 10.8, 10.3 LTS

10.3 LTS 10.2, 7.11 LTS

7.11 LTS 7.11 LTS
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File compatibility example

For example, when you create a .dxp analysis file in Spotfire 11.3, the file is saved with
compatibility versions for 11.2 and 10.10 LTS. You can open the .dxp file in any older Spotfire
version that either is one of those versions, or has 11.2 or 10.10 as compatibility versions.

That means you can open the .dxp analysis file that you saved in Spotfire 11.3 in the following
older versions: 11.2, 11.1, 11.0 and 10.10 LTS.

Newer and older versions of Spotfire Analyst client can be used to connect to the current version of
Spotfire Server in order to upgrade or downgrade the client packages. However, it is recommended
to always run the same version of client and server in production environments. See System
Requirements.

TIBCO Spotfire® Analyst Release Notes

http://spotfi.re/sr
http://spotfi.re/sr


19

TIBCO Documentation and Support Services

For information about the Spotfire products, you can read the documentation, contact TIBCO Support,
and join the TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The website is updated frequently and is more current than any other documentation included with the
product.

TIBCO Spotfire Documentation

The documentation for all Spotfire products is available on the TIBCO Spotfire® Documentation page.
This page takes you directly to the latest version of each document.

To see documents for a specific Spotfire product or version, click the link of the product under 'Other
versions', and on the product page, choose your version from the top right selector.

Release Version Support

Some release versions of TIBCO Spotfire products are designated as long-term support (LTS) versions.
LTS versions are typically supported for up to 36 months from release. Defect corrections will typically
be delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See
also https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm.

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit http://spotfi.re/sr.

How to join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

For quick access to TIBCO Spotfire content, see https://community.tibco.com/products/spotfire.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY
(OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE
FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END
USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO Spotfire, TIBCO Spotfire Analyst, TIBCO Spotfire
Automation Services, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Enterprise Runtime
for R, TIBCO Enterprise Runtime for R - Server Edition, TERR, TERR Server Edition, and TIBCO
Spotfire Statistics Services are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme.txt file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/
OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2022. TIBCO Software Inc. All Rights Reserved.
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